Introduction to Eudora Email
Using Your Password

Each time you open Eudora and check mail for the first time, you need to enter a password for your
POP (Post Office Protocol) account. This password is required by the server before it will transfer
your mail from the server to your Eudora mailbox. No one can get your mail from the server
without your password. The default password given to everyone to access their mail is: lpss
 Note: This does not protect your mail once it is on your PC.

Anyone can read any messages that you have in your
Eudora mailboxes.

When you open Eudora, the Enter Password dialog box will be displayed. Enter you password and
click OK.

Enter
lpss
here

 Note: The password is CASE-SENSITIVE, to the uppercase and lowercase

characters must be typed in exactly. Be sure that Caps Lock is off when you type
lpss

If your password is rejected, an error message is displayed indicating “Shhh Don’t tell anyone” and
“ERR User Unknown”. This is an indication that you have entered the wrong password or your user
name is incorrect. Select Check Mail from the File menu or click the Check Mail icon to redisplay
the password dialog box.

Changing Your Password

To change your password, select Special from the File menu. Select Change Password. You are
prompted to enter your old password once and your new password twice. Depending on the server
you are using the password can be up to 30 characters, but normally it is only 7 or 8. When you
choose a new password, try not to use real words, names, dates, etc. Make sure it is something you
can remember. The system DOES NOT record your password. If you forget it, your entire
account must be deleted and reentered.

The Toolbar

Place the cursor on any button and the button label will appear, explaining the function of the
button. To configure the Eudora toolbar, place the cursor on a blank area of the toolbar, right click
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and chose Customize. Add buttons to the toolbar by dragging from the open window to the toolbar.
Delete buttons from the toolbar by simply dragging the button off the toolbar.

Creating and Sending a Message
An outgoing message is a message you send to someone else. The outgoing message window consists
of the Message Header and the Message Body as displayed below. The Header includes the To,
From, Subject, Cc, Bcc, and Attachments fields:

Message Header

Message Body

1.
2.
3.
4.
5.

From the Message menu, choose New Message or click the New Message icon on the
toolbar.
Type an email address (or a nickname you created in the address book) in the To: field.
Press Tab to move the cursor to the Subject: field.
Type the subject of your message (a short phrase).
Press Tab and type an email address in the Cc: field (optional). This is the carbon copy
field. Recipients in this field will receive a carbon copy of the message.
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6. Press Tab and type an email address in the Bcc: field (optional). This is the blind carbon
copy field. Recipients will receive the message, but the person in the To: field will not know
the message was sent to someone else.
7. Press Tab and type the body of the message. Word processing options (word wrap, tabs,
etc.) are set and explained in the Eudora Setup Options sections.
8. If you would like to keep a copy of the email you are sending, you must click on the Keep
Copy button before you click Send.

9. Press the return receipt button before you click Send when you would like the recipient to
send notification that your sent message has been opened.
10. When you are replying to an email message and you need to keep a hard copy on file, you
must print the hard copy before you click Send.
11. After completing the message, click Send. The message will be sent immediately.
 Tip: You can type multiple addresses in the To:, Cc:, and Bcc: fields, as long as you

separate them with commas.

 Tip: You can save a message without sending it by selecting Save from the File

menu. Your message is saved in the Out mailbox. It can be reopened and edited at
any time prior to sending it.

Additional Features

Address e-mails quickly and easily with automatic name completion. Eudora completes the names by
looking for the names in either your history file or address book. This feature can by turned off or
on in Eudora Setup Options.
1. Enjoy the advantages of a word processor with automatic spell checking and the ability to
choose numerous fonts, formatting, and color settings. The formatting toolbar appears at
the top of each outgoing message window and becomes active when typing in the body
message. Remember that the formatting your recipient sees depends on how well their
email package supports these standards.
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Signatures

A signature is a few lines of text that is added automatically to the end of an outgoing message
when it is sent. A signature can by whatever you want, but it is mostly used to give contact
information such as telephone, address, etc.). You use only one signature at a time in a message, but
you can create as many different signatures as you want.
 Note: In older versions of Eudora, your signature is not displayed in the Eudora

message window, but is added to the end of the message when it is sent.

From the Tools menu, choose Signatures or click the Signature button at the bottom of the mailbox
window.

Standard Signatures
Double click on Standard and the window to create your signature will open. The standard signature
is the default that will attach to all outgoing messages unless you specify otherwise in the Eudora
Setup Options. Enter the text for your signature. Note that while Eudora allows you to enter
styled text in your signature file, older e-mail programs can have trouble reading them. Unless
you’re certain that your fiends/colleagues are using up-to-date email programs, you may not want to
use styled text in your signature.
Once you have created your signature, close the window and choose to Save the signature.
Alternate Signature
Create an alternate signature in the same manner. Alternate signatures might be personal
signatures for signing personal email as opposed to a business signature or a second signature if two
or more people such as husband, children, etc. are using the computer.
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Additional Signatures
To create additional signatures, open the Signature window and right-click anywhere inside that
window. Choose New from the drip-down menu.
Eudora displays the Create New Signature dialog box, asking you for a name. In the dialog box,
enter a signature name and click OK.
A signature window appears. In this window, enter the text for this particular signature.
Selecting a Signature
To include a different signature from the default in an outgoing message, select the signature you
want from the Signature drop-down on the message toolbar. That signature will attach to this one
message only.

Sending Messages with Attachments

Any file can be attached to and sent with a Eudora message. The attached document does not
appear within the email message. Instead the name of the document appears automatically in the
Attached field of the message header. The recipient will see a link to the attachment instead
inserted after the message text.

This denotes that
a message has
been attached.

To attach a file to an outgoing message:
1. Place the cursor in the Attach field of the message header. From the Message menu, chose
Attach File or click the Attach File button on the Toolbar.
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2. Locate the folder that contains the file you want. Select it and click the Open button to
attach the document to the current message. You can add as many attachments as you want
to a message, one at a time.

3. Complete your message and click the Send button. Your message and the attachment will be
sent.

Receiving Attachments

Attachments are saved in the Attach Directory in you Eudora Directory. If you receive multiple
attachments with the same name, a number is added to the end of each duplicate name in the order
they are received. Attachments are displayed as an icon and as a link at the bottom of incoming
messages.
To open an attachment from the open message window, click the attachment name or its icon. If
you have the application that the attachment was created in, that application launches and the
attachment opens.
 Note: Attachments are not automatically deleted from the Eudora Attach folder

unless you have set the Options to do so. It is wise to check the Attach folder
periodically and delete unwanted attachments.

Checking for and Receiving Mail

You can manually check for mail or set up Eudora to automatically check for mail. Eudora
automatically checks for mail at the interval you request. Automatic mail checking will be covered
in the Eudora Setup Options. To check mail manually:
1. From the File menu, choose Check Mail or click on the Check Mail Button on the toolbar.
2. If Eudora asks for you password, type it in the Password dialog box and click OK (Server
passwords are case-sensitive).
3. If there is no mail for you, a “no mail” alert appears. Click OK.
4. If you have new mail, Eudora transfers the messages one by one and then displays a “new
mail” alert. Click OK. New messages are delivered to your In mailbox. This mailbox
automatically opens and your new messages are added to the end of the mailbox list.
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5. Double-click on a message to open the message.
6. To stop a mail check in the middle, click the Stop button in the progress window.

Replying to a Message

1. Select or open the message you want to reply to.
2. From the Message menu, choose Reply or click the Reply button on the toolbar to display a
new composition window. Eudora completes the To:, From:, and Subject: fields based on the
original message.
3. Remove those parts of the original text that you don’t want to include in your reply and type
in your own text.
4. When you finish your response, click Send.

Forwarding a Message

A new message window appears with your address in the From field, the original subject is preceded
by “Fwd.” and a space in the Subject field, the original sender’s text quoted in the message body,
and the original attachments in the Attached field.
1. Select or open the message you want to forward.
2. From the Message menu, choose Forward or click the Forward button on the toolbar
to the new composition window.
3. Type the addresses of the people you want to forward the message to in the To:
field.
4. The existing text may be edited, and more text may be added to the message.
5. After editing the message, click Send to forward it.

Redirecting a Message

Eudora’s Redirect command lets you pass on a received message that was intended for someone
else, allowing that person to reply directly to the original sender. A new message window appears
with the original sender’s address in the From field and the statement “by way of” followed by your
real name and/or return address, the original sender’s text in the message body, and the original
attachments in the Attached field.
1. Select or open the message you want to redirect.
2. From the Message menu, choose Redirect to display a new composition window. Eudora
completes the From: field with the address of the originator, followed by parentheses by
the words “by way of” and your name and/or email addresses. The Subject: field and
message body are also completed based on the original message.
3. Type the addressed of the people to whom you wish to redirect the message in the To:
field.
4. The existing text may be edited, and more text may be added to the message.
5. Once the editing is completed, click Send.
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Deleting Messages
Deleting messages is a two-step process: the message first goes into the Trash, then needs to be
deleted from the Trash. To delete a message, select the message and press the Delete key on the
keyboard. The message is transferred to the Trash mailbox. You can also delete a message by
clicking one time on the message to highlight that message, then clicking on the icon of the trash
can.
To delete the messages in the Trash mailbox (removing them permanently from your computer), do
one of the following:
 From the Special menu, choose Empty Trash, or
 Right-click the Trash mailbox icon, choose Empty Trash from the menu, or
 Open the Trash mailbox, go to Edit, Select All, and press the Delete key.

Symbols in Message Boxes
Message has not been read.
Message has been forwarded.
Message has been replied to.
Message has been redirected.
Message has been read.

Message has an attachment.

Using the Address Book

The Address Book is where you keep information about individuals or groups that you correspond
with. Each entry in the Address Book includes a nickname for a person or group, their full e-mail
addresses, a real name, any contact information, and any notes. You can also use the Address Book
to put nicknames on the Quick Recipient List, and to address a new message.
There are two ways to use your Eudora address book.
1. Short, easy-to-remember entries for individual people.
2. One entry for a whole list of addresses (distribution list).

Creating an Address Book Entry:
1.

Open the Address Book window by going to Tools, Address Book or click on the address
book icon on the toolbar.
2. Click the New button.
3. Enter the name of the entry to the right where you see Untitled. The entry can be a single
entry or a group entry, like Bosses. Check off “Recipient list” if you think you’ll use this
entry often.

8

Recipient list

New Button

4. Type or paste the email address(es) you want for this nickname in the box. “This
nickname will…” If you are creating a group entry multiple addresses must be separated by
commas or carriage return.
5. Additional information for each entry may be added in the areas Home, Work, or Other.
(This is optional.)
6. From the address book, if you highlight the nickname then click one of the bottom
button on the left hand side of the window, you can send a message To someone, Cc, or Bcc
someone. Highlighting a nickname and clicking the Del button will delete that name and all
information attached to it from the address book.

Checking Email from Home (2 options)

Option 1
Employees of the Lafayette Parish School Board can check their LPSS email account using
an Internet browser such as Internet Explorer. In the address line of you Internet
browser type: http://www.mail2web.com and press the enter key on your
keyboard. When the screen appears (pictured on next page) type in your complete email
address and your password then click Check Mail.
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Type your complete
email address.
Type your password

This program does allow you to view any attachments that might have been sent with your email.
Option 2
In the address line of your Internet browser type: http://mail.lpssonline.com and press the enter
key on your keyboard. This will enable you to enter the web based section of the email. Type in
your email address and your password and click enter GMS.
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You will then get a screen that will allow you to view, reply, delete or forward your messages. This
program does not show any attachments that might have been sent with your email. Also unless you
delete a message it will stay on the server so be sure to delete messages that you do not need.

Eudora Setup Options
Setup
To Manually Setup or customize Eudora go to Tools, and select Options. Use the scroll bar to scroll
down the list and set options for each category area. To get help on any item simply click the “?” in
the upper right hand corner of the Options window, then click the topic—a popup window will explain
the topic. Some options displayed on the following screens are required and some are
recommended. Required options must be set as shown in the diagrams that follow and are clearly
labeled!
The following categories can be skipped completely and left with the default setting. These
categories require no changes and if changes are made, it could result in Eudora not functioning
properly. Ignore these categories:
Internet Dialup
Auto Completion
Labels
Automation
MAPI
Auto Configure
Date Display

Background Tasks
Extra Warning
Advanced Network
Kerberos
Styled Text
Statistics
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The first field under TOOLS and OPTIONS is GETTING STARTED. All fields in this area are
REQUIRED.
The following screen shots from the OPTIONS Window are in the order in which they are listed in
the program. Recommended and required settings are marked on each picture.

Substitute John K. Doe
with your real name.
Substitute jkdoe with your user name
and complete with @lpssonline.com

Substitute with your user name

Must be
exactly as
shown.
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Make NO changes to this
screen!

All 3 of these boxes
should be checked!
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If you create a signature, use
the arrow to select it here.
To automatically keep copies of
ALLmail you send, place a check on
Keep Copies. If this option is
checked, you must manually delete
messages saved in your Out
Mailbox.

If you do not wish to include a
signature when replying, take the
check out of this box.

14

15

Remove the checks from
Show cool bars and
Show status bar.

Divides the screen in two.
Allows you to preview the email
without opening it--remains marked
as “unread”. (Optional preference)
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This page is set to personal
preference.
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Press the bar to select a
different sound alert.

This page is set to personal
preference. RecommendedLeave OFF by not checking
box!
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